CHAPTER 2

Installing CiscoWorks Common
Services

This chapter consists of:
¢ Installation Overview
e Preparing to Install CiscoWorks Common Services
e Performing a New Installation
e Performing an Upgrade Installation
e Verifying the Installation

¢ Uninstalling CiscoWorks Common Services

Installation Overview

This section provides overview of CiscoWorks Common Services installation
task. Table 2-1 contains references to more detailed information about each task.
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Table 2-1 Installing CiscoWorks Common Services Task Overview

Task Steps References

Prepare to install 1. Verify server requirements are  |“Prerequisites” chapter, “Server
CiscoWorks met Requirements” section on page 1-2

Common Services.

2. [Install required Microsoft “Installing the Required Microsoft
software on the server if it is not |Software” section on page 2-4
already installed

3. Verify client requirements are “Prerequisites” chapter, “Client
met Requirements” section on page 1-4

4. Verify TCP ports that “TCP and UDP Ports Used” section on

CiscoWorks uses and check for
conflicts with existing
applications

page 2-5

Install server

Run the installation program

“Performing a New Installation” section

software. on page 2-7
“Performing an Upgrade Installation”
section on page 2-16
Verify and 1. Verify that all correct services “Verifying the Installation” section on
troubleshoot are installed page 2-30
installation. 2. Analyze installation error “Troubleshooting the Installation”

messages

appendix, “Understanding Installation
Messages” section on page A-4

Installation Notes

Note

During installation, you might see warnings from the Windows system that it has
found a read-only file.

You might also see warnings that the installation system is running out of disk
space. You can choose to free disk space on the system and click Yes to continue,
or click No to exit the installation.

Do not select an encrypted directory. CiscoWorks does not support directory
encryption.
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Preparing to Install CiscoWorks Common Services

Before you install CiscoWorks Common Services, make sure your server and
client environments meet the hardware and software requirements described in the
“Prerequisites” chapter.

While preparing to install CiscoWorks Common Services,

¢ Do not install CiscoWorks on a system that is configured as a primary or
backup domain controller.

¢ Do not install CiscoWorks on a FAT file system.
¢ Do not install CiscoWorks on Windows XP.

e Run the installation from a local CD or a local hard drive to avoid errors due
to slow network performance.

¢ Close all applications before running CiscoWorks installation.
¢ Do not run any other program when installation is in progress.

¢ Do not install on Advanced Server with terminal services enabled in
application server mode.

)

Note  If you are running HP OpenView, the installation might take significantly
longer to complete. Stop all HP OpenView services before installing
CiscoWorks Common Services.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows g
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Installing the Required Microsoft Software

Installing CiscoWorks Common Services requires three or more Microsoft
software applications. This depends on your system. The major steps required for
installing the CiscoWorks Common Services software are:

1.

Make sure the system has Microsoft Windows or Advanced server with
service pack 3 installed.

To verify the existing service pack:
a. From the Start menu, select Run and enter winver.

If version 5.0 Service Pack 3 appears in the Version field, Service
Pack 3 is already installed.

If this information does not appear, Service Pack 3 is not installed. Install it
now.

Make sure Microsoft Internet Explorer 6.0 is installed in the client and is
running JVM version 5.0.0.3802 and later. To verify the JVM version:

a. From the browser, select View > Java Console.

b. If Java Console is not listed in View, enable it. Select Tools > Internet
Options > Advanced.

¢. In the Microsoft VM section, select the Java Console enabled.
d. Restart Internet Explorer.

Make sure ODBC Driver Manager 3.5.10 or later is installed. To verify the
version of ODBC Driver Manager:

a. From the Windows desktop, select Start > Settings > Control Panel >
Administrative Tools > Data Sources (ODBC).

b. Select the About tab.
If necessary, install Microsoft Data Access Component (MDAC) 2.5 or later.

Make sure that all ODBC Core Components have the same version number.
See the Microsoft web site for installation instructions.

The download and installation programs for these software packages might be
changed by Microsoft at their discretion. Therefore, it is not possible to provide
exact instructions for the installation of the required Microsoft software.
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Remember these points while installing the required server software:

Always keep the newer file when you are prompted by an installation program
to replace a newer file with an older file.

Always reboot your system when you are prompted to do so by an installation
program.

You might be asked to register with Microsoft before downloading some of
the required software. Complete the registration. Selections you make during
registration will not affect the installation.

TCP and UDP Ports Used

CiscoWorks Common Services uses the following TCP and UDP ports.

Incoming Ports

The following ports are used for incoming traffic:

42343/tcp (JRun)

57860/tcp (JRun Server Manager ControlServer - Used for Jrun
Administration)

42344/tcp (ANI HTTP server)

514/udp (Standard port for Syslog)

1741/tcp (port used for the CiscoWorks HTTP server)
1742/tcp (used when the webserver is running on SSL mode)

See the “Preparing to Use CiscoWorks Common Services” chapter for
information on accessing the server.

Database ports: 43441-43449 (Different applications uses different ports.
For example, CiscoWorks Common Services uses 43441 and Essentials uses
43442)

443/tcp (port used for Core Apache Web server in SSL mode)
9007/tcp (Ajp12 connector used by Tomcat)

9009/tcp (Ajpl3 connector used by Tomcat)

1751/tcp (port used for the Core Apache Web server).

[ 78-15430-01
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Outgoing Ports

The following ports are used for outgoing traffic:
e 161/udp (Standard port for SNMP Polling)
e 162/udp (Standard port for SNMP Traps)
e 23/tcp (Standard port for Telnet)
e 22/tcp (Standard port for SSH)
e 80/tcp (Default HTTP for device navigator).

Incoming and Outgoing Ports

The following ports are used for incoming and outgoing traffic:

e 42340/tcp (CiscoWorks Daemon Manager, the tool that manages server
processes)

e 42342/udp (Osagent)

e 42352/tcp (default port; alternate port: 44352/tcp) (ESS HTTP port)

e 69/udp (Standard port for TFTP)

e 1683 (IIOP port for CiscoWorks gatekeeper)

e 8088 (HIOP port for CiscoWorks gatekeeper)

e 5l14/tcp (RCP port)

e 42351/tcp (default port; alternate port: 44351/tcp) (ESS Listening port)
e 42353/tcp (default port; alternate port: 44353/tcp) (ESS Routing port)
e 42350/udp (default port; alternate port: 44350/udp (ESS Service port)
e 10033 (licensing database port)

e 1684/tcp (IIOP gatekeeper port).

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Performing a New Installation

The CiscoWorks Common Services installation program takes approximately 20
minutes to complete on a Windows system with the minimum required hardware.
This can extend to one hour if you perform network management integration
during the installation process.

For information on setting up multi-homed systems, see the Release Notes for
CiscoWorks Common Services 2.2 (Includes CiscoView 5.5) on Windows.

Running the Installation Program—New Installation

To run the installation program:

Step 1 Install the required software as described in the “Server Requirements” section on
page 1-2.

e If you are running Windows, make sure Service Pack 3 is installed.

S

Note  With service Pack 2, CiscoWorks Common Services will install with a
warning to proceed at your own risk.

e If you have Service Pack 1, the installation stops.

e Ifyou are running virus scan while installing CiscoWorks Common Services,
the installation might take longer to complete.

e If you are running HP OpenView, the installation might take significantly
longer to complete. Stop all HP OpenView services before installing
CiscoWorks Common Services.

Insert the CiscoWorks Common Services CD-ROM into a CD-ROM drive. The
Installer screen appears.

Step2  Click Install to continue.
The Welcome screen appears.
Step3  Click Next to continue.

The software License Agreement dialog box appears.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Step4  Click Yes to accept the license agreement and proceed with the installation.
The Setup Type dialog box appears.
To deny the agreement and stop the installation, click No.

Step5  Select one of the following:

e Express to install all CiscoWorks Common Services components in the
default location with default settings.
(See the “New Installation—Express” section.)

e Typical to select CiscoWorks Common Services components and install the
selected components in a specific location. This is the default installation
mode.

(See the “New Installation—Typical” section.)

e Custom to select optional components, customize the settings, and to specify
the location.
(See the “New Installation—Custom” section.)

New Installation—Express

If you select the Express option:

Step 1 Click Next to continue.

The installation program checks dependencies and system requirements. The
Requirements Verification dialog box appears.

The Requirements Verification dialog displays the system requirements, available
space in the drive and Temp Directory (% TEMP%), and available memory in
megabytes.

e If your system does not meet the requirements a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Please select
another drive, or free some space on drive drive name.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Performing a New Installation

Click Next to continue.

The Change Admin Password dialog box appears.

Enter the admin password and confirm it.

For more information on passwords, see “Password Information” appendix.
Click Next to continue.

Change Casuser Password dialog box appears. The dialog box appears only if the
random password generated by the installation is rejected by Windows.

Casuser is the user who administers and maintains CiscoWorks server without
having root privileges.

Enter a password and confirm it.

This password must conform to the system administrator policies. If you do not
enter a password, the installation program generates a random password. The
installation program adds the new user casuser and the new group casusers to the
system.

For more information on passwords see “Password Information”appendix.
Click Next to continue.

The Summary dialog box appears displaying the summary of settings for the
installation.

If you want to view passwords and security sensitive data, click Show Details.
You can select and copy the data from the summary dialog box.

Click Next to continue.
After the installation is completed, End of Installation dialog box appears.

Select Yes, then click Finish.

[ 78-15430-01
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A

To prepare the client system for use. See the “Preparing to Use CiscoWorks
Common Services” chapter.

Caution

You must restart your system after installation is complete. The installation of
other CiscoWorks products can fail if you do not restart.

For troubleshooting information, see the “Troubleshooting the Installation”
appendix.

New Installation—Typical

Step 1

Step 2

Step 3

If you select Typical option:

Click Next to continue.

The Destination dialog box appears with the default location.
To select another location, click Browse.

Click Next to continue.

The Select Component dialog box appears.

Select the components you want to install:

~

Note If CiscoWorks Common Services has been installed previously on this
system, the list of components will be different.

1. CiscoWorks Common Services 2.2 (CWCS) to install CiscoWorks
Common Services 2.2.
(Select this option only if you do not want CiscoView 5.5 or Integration
Utility 1.5 installed.)

2. CiscoView 5.5 to install both CiscoView and CiscoWorks Common Services.

3. Integration Utility 1.5.
(For information about the Integration Utility and third-party NMS
integration, see Using CiscoView.)

i 'nstallation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Performing a New Installation

Click Next to continue.

The installation program checks dependencies and system requirements. The
Requirements Verification dialog box appears.

The Requirements Verification dialog displays the system requirements, available
space in the drive and Temp Directory (% TEMP%), and available memory in
megabytes.

e If your system does not meet the requirements, a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Please select
another drive, or free some space on drive drive name.

Click Next.

The Change Admin Password dialog box appears.

Enter the password and confirm it.

For more information on passwords, see “Password Information”appendix.
Click Next to continue.

Change Casuser Password dialog box appears.

This dialog box appears only if the random password generated by the installation
is rejected by Windows.

Casuser is the user who administers and maintains CiscoWorks Server without
having adminstrative privileges.

Enter the casuser password and confirm it.

The password must conform to the system administrator policies. If you do not
enter a password, the installation program generates a random password and adds
the new user casuser and the new group casusers to the system.

Click Next to continue.

The Summary dialog box appears, displaying the summary of settings for the
installation.

If you want to view passwords and security sensitive data, click Show Details.
You can select and copy the data from the summary dialog box.

[ 78-15430-01
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Step 10

Step 11

A

Click Next to continue. After the installation is completed, End of Installation
dialog box appears.

Select Yes, then click Finish.

To prepare the client system for use. See the “Preparing to Use CiscoWorks
Common Services” chapter.

Caution

You must restart your system after installation is complete. The installation of
other CiscoWorks products can fail if you do not restart.

For troubleshooting information, see the “Troubleshooting the Installation”
appendix.

New Installation—Custom

Step 1

Step 2

If you select the Custom option:

Click Next to continue.
The Select Destination dialog box appears.

Click Next to accept the default location or select another location and click OK,
then click Next.

Do not select an encrypted directory. CiscoWorks does not support directory
encryption.

The Select Components dialog box appears.

i 'nstallation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Performing a New Installation

Select the components you want to install:

1. CiscoWorks Common Services 2.2 (CWCYS) to install CiscoWorks
Common Services.
(Select this option only if you do not want CiscoView 5.5 or Integration
Utility1.5 installed.)

2. CiscoView 5.5 to install both CiscoView 5.5 and CiscoWorks Common
Services 2.2.

3. Integration Utility 1.5.
(For information about the Integration Utility and third-party NMS
integration, see Using CiscoView.)

Click Next to continue.

The Requirements Verification dialog box appears. It displays the system
requirements, available space in the drive and Temp Directory(%TEMP%), and
available memory in megabytes.

e If your system does not meet the requirements a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Please select
another drive, or free some space on drive drive name.

Click Next to continue.

The Change Admin and Guest Password dialog box appears.

Enter Admin and Guest passwords and confirm it.

For more information on passwords, see “Password Information”appendix.
Click Next to continue installation.

The Casuser Password dialog box appears.

Casuser is the user who administers and maintains CiscoWorks Server without
having administrative privileges.

Enter the password and confirm it.

If you do not enter a password, the installation program generates a random

password and adds the new user casuser and the new group casusers to the
system.

[ 78-15430-01
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Step 9

Step 10

Step 11

Step 12

Step 13
Step 14

Step 15

Step 16

Step 17

Step 18

Click Next to continue installation.

The User Management dialog box appears. This dialog box allows you to specify
whether the users are managed locally by CiscoWorks Common Services or by the
Access Control Server (ACS).

e Ifyouchoose to manage users locally, then click Next. CiscoWorks Common
Services Database Password dialog box appears. Skip to Step 11.

e Ifyouchoose ACS option, then click Next. Access Control Server dialog box
appears.

Enter Access Control Server information.

Installation does not attempt to access ACS. You can modify the ACS properties
later using the user administration.

Click Next to continue installation.

The CiscoWorks Common Services Database Configuration dialog box appears.
Enter the CiscoWorks Common Services Database password and confirm it.

Click Next to continue installation.

The Licensing Database Configuration dialog box appears.
Enter the port number, password, and confirm it.

Click Next to continue installation.

The Web Server Configuration dialog box appears.

Enter HTTPS port, server administrator e-mail address, and the SMTP server
name. The SMTP server name is used by other CiscoWorks modules.

Click Next to continue installation.

The Self-signed Certificate dialog box appears. The webserver uses the
self-signed certificate while operating in secure mode.

Enter the country code, state, city, company, organization, and host name for
HTTPS.

The host name is mandatory.
Click Next to continue installation.
The Shortcut Creation dialog box appears.

Select Create a short cut to CiscoWorks on the Desktop to create the shortcut.

i 'nstallation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Step 19

Step 20

Step 21

Performing a New Installation

Click Next to continue installation.
The Integration Utility dialog box appears.
Select one of the following:

e Integrate Later to integrate with a third-party NMS after installation. This
completes the installation more quickly and avoids installation failure due to
errors in the third-party integration.

If you select Later, skip to Step 21.

e Integrate Now to integrate with a third-party NMS during installation.
If you select Integrate Now, continue with steps a through d.

a. Click Next to continue. The Integration Utility dialog box appears,
displaying a list of adapters.

b. Select the adapter from the list of available adapters, or other to choose
an adapter that is not listed (you will be prompted to enter the path name
of the adapter), or none to integrate after the installation is complete.
If you select none, skip to Step 22.

The Integration Utility dialog box appears. Specify whether you want to
enable download options from the Cisco Web page (Cisco.com).

Note  If you are installing only the Integration Utility, enter the CiscoWorks
Server name, protocol type (HTTP, HTTPS) and port number.

c. Select one of the following:

- No to disable future upgrades from the Cisco Web page.
- Yes to enable future upgrades from the Cisco Web page.
d. Enter your Cisco.com user ID and password.

You must have Cisco.com login privileges. If you do not have a user
account and password on Cisco.com, contact your channel partner or
enter a request on the standard Cisco.com web site (www.cisco.com).

Click Next to continue.

The Summary dialog box appears, displaying the summary of settings for the
installation.

To view passwords and security sensitive data, click Show Details. You can select
and copy the data from the Summary dialog box.
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Installation and Setup Guide for Common Services (Includes CiscoView) on Windows g




Chapter2 Installing CiscoWorks Common Services |

M Performing an Upgrade Installation

Step22 Click Next to continue.
After the installation is completed, End of Installation dialog box appears.

Step23 Select Yes and click Finish.

To prepare the client system for use. See the “Preparing to Use CiscoWorks
Common Services” chapter.

A

Caution  You must restart your system after installation is complete. The installation of
other CiscoWorks products may fail if you do not restart.

For troubleshooting information, see the “Troubleshooting the Installation”
appendix.

Performing an Upgrade Installation

CiscoWorks Common Services 2.2 supports upgrade from:
e CD One, 5th Edition
e CD One, 4th Edition
e CD One, 5th Edition + CORE 1.0
e COREI1L.0
The data is preserved when you perform an upgrade.

For a description of the different upgrade paths and their results, see the “Upgrade
Paths” section on page 1-2.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Upgrading from Earlier Versions

You can upgrade to CiscoWorks Common Services 2.2 using either of two
methods:

e Perform alocal upgrade by installing the new version on the system currently
running a previous version.

or

e Perform a remote upgrade by installing
Common Services 2.2 on a new system and exporting essential data from the
system running earlier editions of CiscoWorks to the new system.

To perform a local upgrade, see “Upgrading from earlier versions—Local
Upgrade” section on page 2-17.

To perform a Remote upgrade, see “Upgrading from earlier versions—Remote
Upgrade” section on page 2-28

Upgrade installation preserves the settings from the product installed earlier.

Upgrading from earlier versions—Local Upgrade

Cisco recommends that you save your data to a backup file before you perform
the local upgrade. If your installation fails, you can retrieve this saved data.

Local upgrade overrides the previous versions. The old version will not be
available after you upgrade to CiscoWorks Common Services 2.2.

Earlier versions of CiscoWorks products are not fully compatible with
CiscoWorks Common Services 2.2. The earlier versions are disabled when you
upgrade. After installation is completed, data from previous versions get carried
over to the new version and restores the active state of the products.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Backing Up Your Data

To backup your data:

Step1  Access the CiscoWorks desktop and log in.

For information, see Accessing the Server section and Logging In section in the
Userguide for CiscoWorks Common Services

Step2  Select Server Configuration > Administration > Database Management >
Back Up Data Now.

The Back Up Data Now dialog box appears.
Step3  Enter the pathname of the target directory.

It is recommended that you use a different directory from the directory where
CiscoWorks is located, for example, C:\backups.

Step4  To begin the backup, click Finish.

This process could take some time to complete. For more information, see the
online help.

Before starting an upgrade, all currently scheduled jobs must be suspended.
Necessary data can then be exported during upgrade to the new version. This data
allows dependent applications to re-enable jobs after upgrade.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Running the Installation Program

To run the installation program:

Step1  Install the required software as described in the “Server Requirements” section on
page 1-2.
e If you are running Windows, make sure Service Pack 3 is installed.
>
Note  With Service Pack 2, CiscoWorks Common Services will install.
However, it dsplays a warning to proceed at your own risk.
e If you have Service Pack 1, the installation stops.
e If you are running virus scan while installing CiscoWorks Common Services,
the installation might take longer to complete.
e If you are running HP OpenView, the installation might take significantly
longer to complete. Stop all HP OpenView services before installing
CiscoWorks Common Services.
Insert the CiscoWorks Common Services CD-ROM into a CD-ROM drive. The
Installer screen appears.
Step2  Click Install to continue.
The Welcome screen appears.
Step3  Click Next to continue.
The software License Agreement dialog box appears.
Step4  Click Yes to accept the license agreement and proceed with the installation.
The Setup Type dialog box appears.
To deny the agreement and stop the installation, click No.
Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Step5  Select one of the following:

e Express to install all CiscoWorks Common Services components in the
default location with default settings.
(See the Upgrade Installation—Express, page 2-20.)

¢ Typical to select CiscoWorks Common Services components and install the
selected components in a specific location. This is the default installation
mode.
(See the Upgrade Installation—Typical, page 2-21.)

¢ Custom to select optional components, customize the settings, and to specify
the location.
(See the Upgrade Installation—Custom, page 2-23.)

Upgrade Installation—Express

If you select the Express option:

Step 1 Click Next to continue.

The installation program checks dependencies and system requirements. The
Requirements Verification dialog box appears.

The Requirements Verification dialog displays the system requirements, available
space in the drive and Temp Directory (% TEMP%), and available memory in
megabytes.

e If your system does not meet the requirements a warning appears:
System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:
There is not enough space in drive drive name. Free some space on

drive drive name

If you have not entered a password for CiscoWorks admin user during the
previous installation, the Change Admin Password dialog box appears. You must
enter a new password for the installation to proceed.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Step 2

Step 3

Step 4

A

Performing an Upgrade Installation

If you have not entered a password for CiscoWorks guest user during the previous
installation, the Change Guest Password dialog box appears. You must enter a new
password for the installation to proceed.

Click Next to continue.

The Summary dialog box appears. The Summary dialog box shows the summary
of settings for the installation.

If you want to view passwords and security sensitive data, click Show Details.
You can select and copy the data from the Summary dialog box.

Click Next to continue.
After the installation is completed, End of Installation dialog box appears.

Select Yes, then click Finish.

To prepare the client system for use. See the “Preparing to Use CiscoWorks
Common Services” chapter.

Caution

You must restart your system after installation is complete. The installation of
other CiscoWorks products may fail if you do not restart.

For troubleshooting information, see the “Troubleshooting the Installation”
appendix.

Upgrade Installation—Typical

Step 1

If you select the Typical option:

Click Next to continue.

The installation program checks dependencies and system requirements. The
Requirements Verification dialog box appears.

The Requirements Verification dialog displays the system requirements, available
space in the drive and Temp Directory (% TEMP%), and available memory in
megabytes.
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Step 2

Step 3

Step 4

A

e If your system does not meet the requirements a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Free some space on
drive drive name.

If you have not entered a password for CiscoWorks admin user during the
previous installation, the Change Admin Password dialog box appears. You must
enter a new password for the installation to proceed.

If you have not entered a password for CiscoWorks guest user during the previous
installation, the Change Guest Password dialog box appears. You must enter a new
password for the installation to proceed.

Click Next to continue.

The Summary dialog box appears. The Summary dialog box shows the summary
of settings for the installation.

To view passwords and security sensitive data, click Show Details. The
installation program displays only the new and changed passwords. You can select
and copy the data from the Summary dialog box.

Click Next to continue.
The installation of CiscoWorks Common Services proceeds.
After the installation is completed, End of Installation dialog box appears.

Select Yes, then click Finish.

To prepare the client system for use. See the “Preparing to Use CiscoWorks
Common Services” chapter.

Caution

You must restart your system after installation is complete.The installation of
other CiscoWorks products may fail if you do not restart.

For troubleshooting information, See the “Troubleshooting the Installation”
appendix.

i 'nstallation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Upgrade Installation—Custom

Custom option preserves the settings from the product installed earlier. Dialog
boxes appear with the settings from the previous installation. You can accept these
values or modify them.

If you select the Custom option:

Step 1 Click Next to continue.

The Requirements Verification dialog box appears. The Requirements
Verification dialog displays the system requirements, available space in the drive
and Temp Directory (%TEMP%), and available memory in megabytes.

e If your system does not meet the requirements a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Free some space on
drive drive name

Step2  Click Next to continue.
The Change Admin and Guest Password dialog box appears.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Step 3

Step 4

Step 5

Step 6

Enter CiscoWorks Admin and Guest passwords and confirm it.

If you have

Then

Entered both CiscoWorks admin and
guest user passwords during the
previous installation.

Leave the fields blank to retain the
existing passwords.

Not entered CiscoWorks admin and
guest user passwords during the
previous installation.

Enter new passwords for the
installation to proceed.

Entered the admin user password and
left the guest user password field blank
during the previous installation.

Installation retains the existing
password for the admin user and
generates a random password for guest
user.

Entered the guest user password and
left the admin user password field
blank during the previous installation.

Enter a new password for admin user.
Leave the guest password field blank to
retain the existing password.

For more information on passwords, see “Password Information”appendix.

Click Next to continue installation.

The Casuser Password dialog box appears.

Casuser is the user who administers and maintains CiscoWorks Server without

having administrative privileges.

Enter the password and confirm it.

Leave the fields blank to use the existing password.

This password must conform to the system administrator policies. The installation
program adds the user casuser and the group casusers to the system.

For more information on passwords, see “Password Information”appendix.

Click Next to continue installation.
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Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Performing an Upgrade Installation

The User Management dialog box appears. This dialog box allows you to specify
whether the users are managed locally by CiscoWorks Common Services or by the
Access Control Server (ACS).

e Ifyouchoose to manage users locally, then click Next, CiscoWorks Common
Services Database Password dialog box appears. Go to Step 8.

e Ifyouchoose ACS option, then click Next, Access Control Server dialog box
appears.

Enter Access Control Server information.

Installation does not attempt to access ACS. You can modify the ACS properties
later using the user administration.

Click Next to continue installation.

The CiscoWorks Common Services Database Configuration dialog box appears.
Enter the password, and confirm it.

Leave the fields blank to use the existing password.

For more information on passwords, see “Password Information” appendix.
Click Next to continue installation.

The Licensing Database configuration dialog box appears.

Enter the port number, database password, and confirm it.

The default port number is 10033. Leave the password field blank to use the
existing password.

For more information on passwords, see “Password Information” appendix.
Click Next to continue installation.
The Web Server Configuration dialog box appears.

Enter HTTPS port, server administrator e-mail address, and the SMTP server
name.

The default HTTPS port number is 443. The SMTP server name is used by other
CiscoWorks modules.

Click Next to continue installation.

The Self-signed Certificate dialog box appears. The webserver uses the
self-signed certificate while operating in secure mode.

[ 78-15430-01
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Step15 Enter the country code, state, city, company, organization, and host name for
HTTPS.

The host name is mandatory.
Step16 Click Next to continue installation.
The Shortcut Creation dialog box appears.
Step17  Select Create a short cut to CiscoWorks on the Desktop to create the shortcut.
Step18 Click Next to continue installation.
The Integration Utility dialog box appears.
Step19 Select one of the following:

¢ Integrate Later to integrate with a third-party NMS after installation. This
completes the installation more quickly and avoids installation failure due to
errors in the third-party integration.
If you select Later, skip to Step 19.

e Integrate Now to integrate with a third-party NMS during installation.
If you select Integrate Now, continue with steps a through d.

a. Click Next to continue. The Integration Utility dialog box appears,
displaying a list of adapters.

b. Select the adapter from the list of available adapters, or select other to
choose an adapter that is not listed (you will be prompted to enter the path
name of the adapter), or select none to integrate after the installation is
complete.

If you select none, skip to Step 19.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Step 20

Step 21

Step 22

A

Performing an Upgrade Installation

The Integration Utility dialog box appears, asking if you want to enable
download options from the Cisco Web page (Cisco.com).

~

Note  If you are installing only the Integration Utility, enter the CiscoWorks
server name, protocol type (HTTP, HTTPS) and port number.

c. Select one of the following:

— No to disable future upgrades from the Cisco Web page.
- Yes to enable future upgrades from the Cisco Web page.
d. Enter your Cisco.com user ID and password.

You must have Cisco.com login privileges. If you do not have a user
account and password on Cisco.com, contact your channel partner or
enter a request on the standard Cisco.com web site.

Click Next to continue.

The Summary dialog box appears, displaying the summary of settings for the
installation.

To view passwords and security sensitive data, Click Show Details. The
installation program displays only the new and changed passwords. You can select
and copy the data from the Summary dialog box.

Click Next to continue.

The installation of CiscoWorks Common Services proceeds. After the installation
is completed, End of Installation dialog box appears.

Select Yes, then click Finish.

To prepare the client system for use, see the “Preparing to Use CiscoWorks
Common Services” chapter.

Caution

You must restart your system after installation is complete. The installation of
other CiscoWorks products may fail if you do not restart.

For troubleshooting information, see the “Troubleshooting the Installation”
appendix.
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Upgrading from earlier versions—Remote Upgrade

Step 1

Step 2

Step 1

Step 2

Step 3

If you do not want to overwrite your current version of CiscoWorks Common
Services, you can perform a remote upgrade. During a remote upgrade, you install
CiscoWorks Common Services on a new system and export all required data to the
new system from the system running the previous version.

Install CiscoWorks Common Services on the new system. See the “Performing a
New Installation” section on page 2-7.

Remove the CiscoWorks Common Services CD-ROM from the new system.

Before starting an upgrade to CiscoWorks Common Services, relevant data from
all jobs must be exported to the new system.

To export the data:

The CiscoWorks Common Services CD-ROM should be in the CD-ROM drive of
the system running the old version of CiscoWorks Common Services. Go to the
root directory on the CiscoWorks Common Services CD-ROM.

Run the script export_cdone.pl
9oNMSROOT%\bin\perl export_cdone.pl

9%NMSROOT% is the directory in which CiscoWorks Common Services is
installed. The default NMSROOT directory is
Default_Installation_Drive:\Program Files\CSCOpx.

The script prompts you for the location where you want to store the data to be
exported.

To accept the default location for storing the exported data, press Enter.
The default location is %NMSROOT %\rigel.

If you do not want to use the default location, enter an alternate location, and press
Enter.

The remote upgrade tool exports the data and creates the directories cmf and
manifest\cmf at the location specified for backing up the data. For example, if you
choose C:\backup as the back up location, the remote upgrade tool creates the
directories C:\backup\cmf and C:\backup\manifest\cmf to store the exported data.
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Step 4

Step 5

Step 6

Note

Performing an Upgrade Installation

Copy the directories cmf and manifest from the system running the old version of
CiscoWorks Common Services into %NMSROOT%\rigel on the system running
the new version of CiscoWorks Common Services.

On the new system, go to the directory %NMSROOT %\rigel\scripts, then
run perl import_cdone.pl.

Run the data import script:
9%0NMSROOT%\bin\perl import_cdone.pl
The remote upgrade tool imports the data exported from the remote system.

The upgrade is now complete and all necessary data from the previous version of
CiscoWorks Common Services has been exported.

During the remote upgrade, the user information from the source is merged with
the new user information.

Reinstalling CiscoWorks Common Services

To reinstall CiscoWorks Common Services, follow the steps under Performing an
Upgrade Installation, page 2-16.

¢ Ifyouleave any field blank, CiscoWorks will use the values from the previous
installation.

If you have not entered a password for CiscoWorks admin or guest user
during the previous installation, you must enter a new password for the
installation to proceed.

e If you select custom mode during reinstallation, all dialogs show the default
values or the settings from the previous installation. You can accept these
values or modify them.

During reinstallation, the installation attempts to use existing passwords. If the
installation fails to generate random passwords, you may provide the passwords
manually.

The installation do not use the randomly generated password if the password does
not comply with the policies set by the local administrator.
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Installation and Setup Guide for Common Services (Includes CiscoView) on Windows g




Chapter2 Installing CiscoWorks Common Services |

I Verifying the Installation

During reinstallation, you can preserve the self-signed certificate. Select Keep
existing certificate option to configure the webserver to use existing certificate.

~
Note If CiscoWorks Common Services has previously been installed on this

system, the product will automatically be installed at the same location
where CiscoWorks Common Services was previously installed.

Verifying the Installation

You can verify product installation by entering the command net start from DOS
prompt. The following services should be displayed:

e CiscoWorks Tomcat Servlet Engine
e (CiscoWorks Daemon Manager

e CiscoWorks Sybase Server

e (CiscoWorks VisiBroker Smart Agent
* CiscoWorks Web Server

e CWCS rsh/rep service

e CWCS syslog service

e CWCS tftp service

¢ JRUN Proxy Server for CWCS.

Uninstalling CiscoWorks Common Services

Use the Uninstall option to remove CiscoWorks Common Services files and
settings. You must be logged in as administrator to remove CiscoWorks Common
Services.

You cannot uninstall CiscoWorks Common Services when you have CiscoView
and Integration Utility installed. Before uninstalling CiscoWorks Common
Services, uninstall CiscoView and CiscoWorks Common Services.

Installation and Setup Guide for Common Services (Includes CiscoView) on Windows
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Uninstalling CiscoWorks Common Services W

If you select CiscoWorks Common Services with out selecting CiscoView, the
following message appears:
Cannot uninstall CiscoWorks Common Services.

It is required for CiscoView.

Uninstall all applications dependent on CiscoWorks Common Services before
uninstalling CiscoWorks Common Services.

Caution

Step 1

Step 2

Step 3

A

You must use the Uninstall option of the CiscoWorks Common Services
installation program to remove the product. If you try to remove CiscoWorks
Common Services or its components manually, you may damage your system.

From the Windows desktop, select Start > Programs > CiscoWorks >
Uninstall CiscoWorks.

The Uninstallation dialog box appears, displaying installed components.
Select the components you want to remove, then click Next.

or

Click Uninstall All to uninstall all the components.

A dialog box appears with the list of selected components.

Click Next to continue uninstallation.

or

Click Back to return to the component selection box. If you have selected
Uninstall All, you cannot return to the component selection box using back
button.

Messages about uninstall preparation appear and the uninstallation finishes.

Caution

You must restart the system after uninstallation to make sure all the registry
entries are deleted.
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